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Introducao

1. O passo a passo das instru¢8es também incluem figuras para fornecer um contexto adicional para a etapa selecionada
Os médulos possuem “starter.dwg files” que devem ser utilizados
O texto em “negrito azul” indica comandos do BricsCAD

O texto em “negrito preto” sdo valores de inser¢do e/ou sele¢do

voA W

Os exercicios sdo em unidades métricas (mm)

Antes de comegar, certifique-se de que as seguintes configuracdes estdo ativadas:
- No Status Bar (canto inferior direito da tela): ESNAP, STRACK, DUCS, DYN, QUAD, RT
- No Command Line: DMEXTRUDEMODE = 3, QUADDISPLAY =5, (opcional - para melhor renderizacdo na tela) ANTIALIASSCREEN = 2
- No Ribbon, sob a aba Home (Isso também pode ser feito no Command Line: SELECTIONMODES = 6)
o Desabilitar a selecdo de bordas (Edges)
o Habilitar a sele¢do de Faces
o Habilitar a selecao de delimitacdes (Boundaries)
- Na janela de configuracdo do Navegador Structure: ‘Select entities when selected in tree’
- Certifique-se de configurar a drvore da estrutura para a configuracdo “Default”

- Painel Structure -> Configuration Structure Tree (default)

I cefait
[Q seardh

B Configure Structure Tree [default] X
W File
Group/Sort  Show/Skip Options

Select entities when selectedin tree
[ 0n entity selection, selectin tree

[ 0n entity selection, expand parent in tree
[CJon entity deselection, collapse in tree

[ Deselect entities on hide

[(Jexplode external references in tree

| oK Cancel
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Interface, visualizacdao e navegacao

Este médulo explica a interface do BricsCAD V22, demonstra como mostrar e ocultar selecionada entidade, fazer se¢des e
como navegar em 3D.

1 Interface Femrym—— —

Welcome to BricsCAD Pro.

1.1 BricsCAD Launcher

Ao iniciar o BricsCAD, é mostrado o Launcher. Aqui vocé

pode selecionar seu ambiente de trabalho. Uma vez que @ B O @
nosso treinamento é para modelagem, selecionaremos o o S St e o
ambiuente de trabalho 3D Modeling. o D = R Rl
(@5 Launch BricsCAD Shape > Last used: Civil >
Dot show again Units:  Metric
1_2 COmegando Home solid surface Mesh Civil Visualize ~ Parametric Insert
! O @ O ¢B-8- HLE- 2 0-8- 9% R L
Na V22 na janela de boas-vindas, vocé possui 3 se¢des | o, eee ¥ ©@-©- @@ To- 2/ G-0- [ SO EONL -
L - - B @36 ©FE B OO T @~ cudea- X B S~ -
principais (1) HOME, (2) LEARN e (3) APPLICATIONS. oty | Dl ot | st e oty
Stat X+
1. A partir da aba HOME vocé pode criar um novo
desenho, escolher as unidades, abrir um desenho ou Get started Recent files
acessar seus arquivos mais recentes @ Home
2. Apartir dasecdo LEARN vocé pode acessar os tutoriais ® Lean a
New drawing
3. Apartir dasecdo APPLICATIONS vocé pode explorar as & Appiications

Template: Defaultmm ~ *

aplicagdes de terceiros

Building_M1.dwg

Open drawing
EastBuilding_2.6.dwg
1.3 Novo Desenho
Get started
Antes de iniciar um novo arquivo, certifique-se que Default-cm Get started
estd usando o template Default-mm. Vocé pode Default-imperial
muda-lo rolando para baixo pelos templates e Default-m e
selecionando Default-mm. 7 Default-mm .
New drawing
More...

Uma vez selecionado o Template Default-mm,
clique no icone “+" para criar um novo de desenho Cancel Template: Defaulemm v
(New drawing).

NOTE: Assim que o model space aparecer, Open drawing Open drawing
verifique se as configurac8es estdo de acordo com
0 acima mencionado na introdugdo.
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1.6

1.7

Menu File

O menu FILE pode ser acessado através do icone do
BricsCAD, no canto superior esquerdo do ribbon.

Interface Escura

O BricsCAD é definido por padrdo a ter uma interface
escura, mas isso pode ser facilmente alterado ao clicar com
o botdo direito do mouse em qualquer lugar do ribbon ou
toolbar, e desmarcando a opg¢do Dark Interface

Ambientes de Trabalho

A alteracao do ambiente de trabalho pode ser feita a partir
do status bar. Se vocé clicar na aba que exibe Modeling, a
lista de diferentes ambientes de trabalho serd exibida.

DICA: Vocé também consegue acessar os ambientes de
trabalho ao clicar com o botdo direito do mouse em
qualquer lugar do ribbon ou toolbar e ir na opcgdo
Workspaces.

Access Toolbar

O BricsCAD Access3D toolbar localizado no topo da sua tela
atua com uma barra de ferramentas rapida. Aqui vocé vai
encontrar as ferramentas de modelagem 3D mais utilizadas.

BricsCAD’
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Vocé consegue acessar essa barra de ferramentas ao clicar
com o botdo direito do mouse no ribbon, selecionar
Toolbars, depois BRICSCAD e Access3D.
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Ribbon Tabs

As ferramentas comuns sdo organizadas em grupos dentro
de abas. Cada aba corresponde a um grupo de
funcionalidades de comando.

BricsCAD’

—p

Manipulate

Selection

- Home solid Surface Mesh Civil Visualize  Parametric Insert Annotate Wiew Manage Output  Pointclouds
O@m F#B0-6- QBLE- PB0-B- 03 &L+ - IR e e w .
S 4 98- 0- QAT P60 LI BGOD - Ty 18 GRE E Brewean
- @ GAG- @@ OOFT @ s XL ST~ pore B 12 @ [ @ F @ wetcn perspective
Modeling Direct Modeling Solid Editing Draw Modify Sections Coordinates Views
Drawing Tabs - Home Solid Surface Mesh
Estes lhe permite alternar facilmente entre diferentes . O @ 0 ¢B-8- 9bLe- 2
H - - | @ &t -
desenhos abertos. P e 4 -9 @ TE- D
“Q 836G »F@EB- OC

DICA: Vocé também pode exibir todos os desenhos abertos
de uma s6 vez navegando para a aba View -> Interface e
selecione para visualizar: Tile horizontal, Tile vertical ou
Cascade the views. Para restaurar para uma Unica vista,
“Maximize” qualquer uma das vistas ativas.

Aba Model

Model Space é uma 4rea na qual vocé cria entidades
bidimensionais e tridimensionais baseadas tanto no World
Coordinate System (WCS) quanto no User Coordinate
System (UCS).

Aba Layout

A aba Layout também pode ser referido como um espago
de visualizacdo de folhas. Este € um ambiente de trabalho
que proporciona a visualizacdo do model space em uma
determinada escala, dependendo do tamanho do papel.

Painéis Dobraveis

Um conjunto de painéis dobraveis que esta disponivel em
ambos os lados da tela. No lado direito vocé encontrara:
Tips, Properties, Components, Details, Compositions,
Profiles, Layers, navegador Mechanical e o painel 24/7. A
maioria destes sera abordada mais adiante neste
documento.

Stat  ® Drawing1 » DrawingZ » Drawing3 X +

View Manage Cutput  Pointclouds

= ﬁ‘ ? E27ile Horizontally
et (x} DTlIe\u"ertlcaIIy
Properties Parameters Mechanical

Panel Browser FD Cascade
Panels Interface

LEE AL E||I'-11::|-|:i||3||La\)ﬂ:nutl Layout2

4470 M E'lMDdE| Layoutl | Layout?
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1.14 Commandline

No lado esquerdo inferior da janela de aplica¢do, vocé pode
digitar os comandos e o BricsCAD ira mostrar prompts,
& : ~ ~ (4]« v [ r] @] Model | Layoutt [ Layoutz [+
opcbes e outras informagdes sobre a execucdo dos 2
comandos aqui. Pressione F2 para mostrar as informacdes

do comando completa em uma janela separada, ou Shift +
F2 para mostrar/ocultar o command line.

Ready
1.15 Status Bar

O Status Bar é posicionado ao longo da margem inferior da
janela de aplicagao do BricsCAD. Possui informacg8es sobre
as configuracdes contidas no desenho atual.

41134.4, 21094.02, 0 Standard ISO-25 BIM SMAP GRID ORTHC POLAR ESMAP STRACK LWT TILE DUCS DYN QUAD RT HKA LOCKUI MNone «

2 Visualizagao

Se vocé trabalha com muitas entidades em um desenho, tudo o que vocé tem no desenho é visivel na vista (Model
Space). Quando vocé quiser tornar temporariamente apenas algumas entidades ou uma entidade em particular visivel
e gerencid-las em uma vista, vocé pode usar as ferramentas Hide ou Isolate.

21 File -> Open -> Starter Files -> Exercise 1 -> Select Main
Building_Start.dwg

Abra o desenho. Selecione o arquivo Main
Building_Start.dwg

2.2 Ocultando Entidades

A ferramenta Hide oculta temporariamente as entidades /
selecionadas na vista. mmj]

Neste desenho, vamos esconder as janelas do edificio a
direita, I 7T
LLLLTT L

1. Selecione as janelas

2. O quad aparece, mova o cursor para a aba Select e
=

clique no icone HIDE ENTITIES [E

Todas as entidades que foram selecionadas estdo ocultas
na vista.

3D Solid, Block Reference (Parametric) (3)

oV P T D

Model Draw Modify  Select Constrain Insert

@ %°[gf ¥

HNTTTTTT
LLLTTITTO |

BELLITIT

LT
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Isolando Entidades

A ferramenta Isolate oculta temporariamente todas as
entidades, exceto aquelas que foram selecionadas.

Neste modelo,
1. Selecione as janelas frontais do edificio a esquerda

2. Uma vez que quad aparece, va para a aba Select e

clique em ISOLATE ENTITIES %

Todas as entidades que foram selecionadas estdo
temporariamente isoladas.

Mostrando entidades

A ferramenta Show Entities traz de volta todas as
entidades ocultas na vista.

Vamos trazer todas as entidades de volta para a vista

1. Clique com o botdo direito do mouse no model space.
O quad aparece no estado de nenhuma selegao

2. Mova o cursor sobre a aba General e clique em SHOW
=

ENTITIES ®

Todas as entidades que foram temporariamente ocultadas
e isoladas serdo mostradas.

Navegador Structure

O navegador Structure também pode ser usado para
ocultar e isolar entidades selecionadas, bem como revelar
todas as entidades ocultas no model space.

=

1. Abra o navegador Structure
dobravel

a partir do painel

2. Certifique-se de que a configuragdo atual esteja
definida como “default”. Caso contrario, clique no
menu com um icone de hambulrguer no canto
superior direito do navegador structure.

3. Selecione os elementos de Block Reference (14).
Todas as entidades sob este elemento serdo
selecionadas

Main Building_Start.dwg -> Entities -> 0 (78) ->
Block References (14)

Block Reference {Parametric) {5)
= DG
& =9 oF

Model Modify Select

Ll S

T &

Constraints Insert

[LIITITIT]

(LTI

No Selection

adlAE @O

Model Draw Insert General

@ M 18
= () R
= 45 P

BE
\a;
[

B
=)

| D

& default

[Q search

& [ Main Building_Start.dwg
5O Entites
g0 o)
-0 30 Sold (64)

-0 SRR

Show
Hide
Isolate

O Zoom
Expand Al
Collapse All

% Configure..
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4. Clique com o botdo direito do mouse e selecione Hide

Todas as janelas foram temporariamente ocultas.

NOTE: Verifique se as configuragdes do navegador
structure estdo corretas clicando no nome “default” na
parte superior do navegador structure. Vocé entrara em
um didlogo onde é necessario ir para a aba Options. La
vocé precisa escolher a pré-selecdo Select entities when
selected in tree a partir do menu suspenso.

Navegar em 3D

BricsCAD’

File

Configure Structure Tree [default] X

Group/Sort  Show/Skip  Options

I Select entites when selectedintree [

On entity selection, select in tree

On entity selection, expand parentin tree
[[] on entity deselection, collapse in tree
Deselect entities on hide

[CJExplode external references in tree

OK Cancel

A medida que vocé navega ao redor e através de seu modelo 3D, a localizacdo do modelo no espaco permanece
constante. E sua vista atual (viewpoint) do modelo que esta mudando.

Navegacdo com Mouse e Teclado

As ferramentas de navega¢do mais usadas sdo o zoom
infout, pan e orbit que pode ser facilmente acessado
através do mouse e do teclado.

1. Zoom in/out - role a roda do mouse

2. Pan - pressione a roda do mouse ou o botdo central
do mouse

3. Orbit - pressione a tecla Shift e a roda do mouse

Aba View no Ribbon

Ferramenta como extra zoom, panning e orbit podem ser
encontradas na aba View no ribbon

Ferramenta de Navegacdo Look From

A ferramenta LookFrom é exibida no canto superior
direito da drea Drawing.

Clique em diferentes lugares na ferramenta LookFrom
para exibir a vista a partir de pontos de vista pré-
definidos.

DICA: Para visualizar os pontos de vista de baixo,
pressione a Tecla Ctrl.

NOTE: Um menu, clicando com o botdo direito do mouse
oferece, acesso a controles e configuracdes adicionais.
Para saber mais, consulte BricsCAD Online Help.

Front

-&
; b

Real-Time
Constrained Sphere 2/ Pan
Navigate
Right /" Mg’ ey
. .HI:I ) jj.D

<

[ &=

Top Front Right Down Front Right

ucs >
View >
Visual Style >

Isometric Mode
Twist Mode

WCs
ucs

Perspective
LookFrom Settings...

Location b

Dismiss

7 P

Real-Time Real-Time

Zoom

LSC

CAD


https://help.bricsys.com/document?title=_guides/BCAD_viewing_your_drawing/GD_thelookfromcontrol.html&documentVersion=V22
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Painel Properties

Mo Selection - 2@
Configurag¢des adicionais de visualizacdo também podem £ General
ser encontradas no painel Properties enquanto nada é Colar [ ByLayer
) L 0
selecionado. aver
Linetype ————— Bylayer
Linetype scale 1
Lineweight ————— Bylayer
1. Perspective: Relata o valor atual da varidvel de Transparency  Bylayer
sistema Perspective; liga e desliga o modo de - E'f“a“"” 0 mm
. . ~ . ew
visualizacdo Perspective. Camera 17181.74, -73870.88, 8500.64
. . . [ . .
2. Visual Style: Relata o Visual Style atual e permite que . :arg'ﬂ \ 3?181 74, 0, 8500.64
~ . . erspecuve n
vocé selecione um diferente. Lens length —
Field of view 38.58
Height 25.9391m
Width 56,36982m
Clipping off
Front plane 73.87088 m
Back plane 0 mm
isual style Modeling
Misc

Annotation scale | 1:1
Default lighting = Off

Selecao de entidades e o cursor Quad

As seguintes etapas demonstrardo como trabalhar com o cursor Quad e destacardo como selecionar entidades de
modelos 3D.

File: New wizard... -> Start from Template -> Next ->

Select: Default-cm.dwt -> Finish Selecta Template
,.dwx i

Defaultmperial.dwt

| Default-m.dwt
Default-mm.dwt
Mechanical2d-ANSL.dwt
Mechanical2d-DIN. dwt
Mechanical 2d-150.dwt.
Mechanical2d-JIS.dwt
Mechanical-cm.dwt

Observe que as unidades de desenho deste arquivo M >
serdo em centimetros. T

You can select an existing drawing to use

as a template for your new drawing. Browse...

Heb <Back Cancel

Usando o Quad

O quad é uma barra de ferramentas flutuante que ajusta
seu conteldo, dependendo do que vocé esta ou ndo

destacando, e do que vocé possa ter selecionado no 5'{* @ E@ @ O @
ambiente de trabalho atual. (=]

Model Draw Insert General

Mo Selection

Vamos comegar com um desenho vazio:

1. Cligue com o botdo direito do mouse no model space.
O quad aparece no estado de nenhuma sele¢do @ O @ O @ ﬁﬁj
2. Mova o cursor sobre a aba Model

17 Ve
@ S P
O grupo de ferramentas é ampliado com mais op¢Ses @) ﬁg - fﬁ L@

de ferramentas

o 8
3. Clique no icone da caixa (BOX) no quad @ J = @ 'q}

4. Desenhe uma caixa 3D simples

No painel Properties em View, mude o Visual style para:
Modeling
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Mo Selection - @ ar
= General
Colar [ ByLayer
Layer 0
Linetype ByLayer
Linetype scale 1
Lineweight Bylayer
Transparency ByLayer
Elevation 0cm
(& View
amera 0,01
Target 0,0,0
Perspective off
Lens length 50 mm
Field of view 33.58
Height 297 cm
Width 545,43 cm
Clipping Off
Front plane 1cm
Back plane 0cm
Visual style 2dwireframe ~
=l Misc 2dWireframe
Annotation scale | conceptual
Default lighting |
(Modeing
Realistic
Shaded
Shaded with edges
Shades of Gray
Sketchy
Wireframe
A-Ray

5. Passe o cursor sobre uma das faces da caixa. O Quad

exibe um Unico icone, que é a ferramenta mais
recentemente utilizada com este tipo de entidade.

6. Clique com o botdo direito do mouse para iniciar a
ferramenta mais recentemente utilizada ou mova o
cursor sobre o icone para expandir ainda mais o Quad.

Modos de sele¢cao

Os modos de selecdo permitem controlar quais sub-
entidades (faces, bordas e fronteiras) se destacam na
visualizacdo da sele¢do e podem ser selecionadas.

1.  Os modos de sele¢do podem ser encontrados no
Access toolbar ou digitando SELECTIONMODES no
command line.

2. Clique nas opgdes face e boundaries.

Select edges estd inativo enquanto select faces e select
boundaries estdo ativos

AN AN

Destacando vs Selecionando entidades

Quando o select Edges esta desligado, select Faces e
Boundary Detection estdo ligados (por padrdo), faca uma
das seguintes opgdes:

1. Passe o cursor mouse sobre a face

A face sélida é destacada em laranja. Quando a face
for realcada, clique nesta face para seleciona-la

2. Passe o mouse sobre uma das faces do sélido
enquanto pressiona a tecla CTRL

O sélido fica azul. Quando o sélido for realcado, clique
no sélido para seleciona-lo

Enable
detection of 3D

solid edges "I

Enable
detection of 3D

solid faces I

Enable
boundary

detection

Destacando/Seleci
Faces

Destacando Sélido

Controla se as bordas do sélido 3D sao
realcadas por pré-selecdo e a partir
dai serem selecionadas.

Controla se as faces do soélido 3D sao
realcadas por pré-selecdo e a partir
dai serem selecionadas.

Controla se sdo detectados limites
fechados no plano XY do sistema de
coordenadas atual ou na face dos
solidos 3D.

onando
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3. Passe o mouse sobre a borda do sélido enquanto
pressiona a tecla CTRL. A borda é exibida em laranja.
Quando a borda for realgada, clique na borda para
seleciona-la

Selecionando muiltiplas entidades com janelas de
selecao

As janelas de sele¢do permitem selecionar uma ou mais
entidades de cada vez.

Ha dois tipos de janelas de sele¢do no BricsCAD:

Janela de seleg¢do azul: Aparece ao criar uma janela da
esquerda para a direita

Caixa de selecdo verde: Aparece ao criar uma caixa da
direita para a esquerda

1. Cligue e mova o mouse para a direita para criar uma
janela azul ao redor da geometria da caixa que vocé ja
criou antes. Quando a caixa estiver completamente
dentro da janela, ela serd adicionada ao conjunto de
selecdo

NOTE: por padrdo, a janela de selecdo seleciona apenas
entidades inteiras (por exemplo, sélidos, linhas, polilinhas,
blocos...) mas ndo sub-entidades (por exemplo, faces de
solidos).

2. Pressione a tecla CTRL uma vez durante a selecdo da
janela para selecionar as faces da caixa 3D

3. Pressione a tecla CTRL duas vezes durante a selecdo
da janela para selecionar as bordas (edges) da caixa
3D

4. Clique e mova 0 mouse para a esquerda para criar
uma janela verde ao redor da geometria da caixa

Quando a caixa sobrepde a janela ou estd completamente
dentro da janela, ela serd adicionada ao conjunto de
selecdo.

Para selecionar faces ou bordas da caixa 3D com a caixa de
selecdo verde, siga 0 mesmo processo como o da caixa de
selecdo azul.

Selecionando Sélido

Destacando/Selecionando
Bordas

BricsCAD’




Exercicio 1: Conceitos basicos
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O seguinte modulo é para se familiarizar com as ferramentas basicas de modelagem

1.1

1.2

13

O Basico

File: New, selecioe Default-cm template. Observe que
as unidades de desenho deste arquivo serdo em
centimetros.

Certifique-se de que vocé esta no ambiente de trabalho
Modeling. A mudanga entre ambientes de trabalho pode
ser feita a partir do status bar. Se vocé clicar com o bot&o
direito do mouse na aba que exibe BIM, a lista de diferentes
ambientes de trabalho sera exibida. Clique em Modeling
para alternar.

Criando uma pasta de projeto

Antes de comecar, salve o arquivo em uma nova pasta. Esta
sera sua pasta de projeto onde documentos adicionais
serdo salvos.

1. Desenhe de uma caixa

2. Mudar a perspectiva do viewport para: Top Front Left.

3. Aferramenta LookFrom é exibida no canto superior
direito da area Drawing.

4. No painel Properties em View mude o Visual style
para: Modeling.

5. Abra o Quad (sem selecdo) clicando com o botdo
direito do mouse em um lugar vazio no Model space
€ mova o cursor sobre o icone.

6. Sob a aba Model, clique no icone da caixa (BOX) O
7. Vocé é solicitado: Set corner of box or [Center]:
8. Digite 0,0,0 e pressione Enter

9. Sdo exibidas duas dimensGes dindmicas que
controlam o comprimento e a largura da caixa (ver
imagem). A dimensdo dinamica que é destacada em
azul é a ativa.

10. Digite um valor de 1000 e pressione a Tecla Tab para
mudar para a outra dimensdo dindmica

11. Note que a primeira dimensdo é agora destacada em
rosa. Isto é para indicar que um valor foi inserido aqui,
e este valor estd agora travado nesta dimensdo
dinamica.

12. Digite um valor de 1000 e pressione Enter.
Alternativamente, vocé pode pressionar Tab

novamente para mudar de volta para a primeira
dimensao dindmica.

Left

Get started

Template: Default-mm

New drawing

Open drawing

-

o
¢

<P

ILsC

CAD
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1.6

13. Finalmente, aparece uma dimensdo dinamica que

controla a altura da caixa. Digite um valor de 1000 e
pressione Enter.

Manipulando face

1.

Mova seu cursor sobre uma face lateral da caixa até
que ela seja realcada.

Abra o Quad, movendo o cursor sobre o icone.

Sob a aba Model do Quad, clique no icone PUSHPULL
£y

Digite um valor na caixa de dimensdo dinamica e
pressione Enter ou clique com o botdo esquerdo do
mouse no local para onde vocé deseja puxar esta face.

Manipulando multiplas faces

1.

Selecione uma face lateral da caixa, clicando com o
botdo esquerdo do mouse

Selecione a face superior da caixa

Quando vocé tiver ambas as faces selecionadas, clique
com o botdo direito do mouse em qualquer lugar em
um espago vazio na tela para abrir o Quad

&
Sob a aba Model, clique no icone PUSHPULL

Ambas as faces serdo agora empurradas para dentro
ou puxadas para fora em distancias iguais.

Digite um valor e pressione Enter ou clique com o
botdo esquerdo do mouse.

Copiando um sélido

1.

Destaque a caixa segurando a tecla Ctrl e pairando
sobre uma das faces da caixa. Ao invés da face, todo o
sélido deve ser realcado agora.

Abra o Quad movendo o cursor sobre o icone, e sob a
O%
aba Modify, clique no icone COPY B

Lhe é solicitado um Base Point. Clique com o botdo
esquerdo do mouse em um dos cantos da caixa.

Lhe é solicitado um Second point. lique com o botdo
esquerdo do mouse onde vocé deseja que a copia da
caixa esteja.

Vocé pode continuar colocando cépias, ou pressionar
Enter ou Esc para sair do comando.

Note que as etapas acima também podem ser feitas
usando BIMCOPY apés destacar uma face de um sélido 3D.

BricsCAD’
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1.8

Exercicio 2: Esculpindo um modelo

Manipulando borda

1.

Destaque uma borda da caixa segurando a tecla Ctrl e
pairando sobre uma das bordas da caixa. Ao invés da
face, a borda deve agora ser realcada.

No Quad sob a aba Model, clique no icone FILLET @

Digite um raio de filete e pressione Enter.

Manipulando muiltiplas bordas

1.

Em vez de dar a uma borda um filete, vamos filetar
todas as bordas da caixa de uma sé vez.

Pressione Ctrl + Z para desfazer sua acdo anterior,
para que o filete da etapa anterior seja removido.

Crie uma janela de sele¢do ao redor da caixa inteira, e
enquanto desenha esta janela, pressione a tecla Ctrl
duas vezes até aparecer um pequeno icone indicando
‘edge selection’ appears (veja imagem).

Agora vocé deve ter selecionado todas as 12 bordas da
caixa. No Quad sob a aba Model, clique no icone

FILLET @

Digite um raio de filete e pressione Enter.

BricsCAD’ LSC

CAD

As etapas a seguir dardo um exemplo de como transformar um estudo de volume simples em geometria real do edificio.
Vocé aprendera algumas ferramentas basicas de modelagem ao longo do caminho.
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Esculpindo um modelo

Arquivo: Novo, selecione Padrao-cm modelo.
Observe que as unidades de desenho deste
arquivo estardo em centimeters.

Verifique se vocé estd no espaco de trabalho
Modelagem.

A alternancia entre espacos de trabalho pode
ser feita a partir da barra de status. Se vocé clicar
com o botdo direito do mouse na guia que exibe
o BIM, a lista de diferentes espacos de trabalho
sera exibida. Clique em Modelagem para
alternar.

Nota: Depois de criar um novo desenho a partir
do modelo, certifique-se de salvar o desenho.
Procure um local facil de encontrar e dé-lhe um
nome (ex. Exercicio 2).

Get started

(m Home e

() Learn

New drawing

& Applications

Template: Default-cm -

Open drawing
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Desenhando uma caixa

1.

10.

11.

12.

Altere a perspectiva do visor para: Frontal
superior esquerdo.

A ferramenta LookFrom é exibida no
canto superior direito da area Desenho.

No painel Propriedades , em Exibir, altere
o estilo Visual para: Modelagem.

Abra o No-Selection Quad clicando com o
botdo direito do mouse em um lugar vazio
na tela e movendo o cursor sobre o icone.

Na guia Modelo, clique no icone CAIXA

¢

Vocé sera solicitado: Definir canto da caixa
ou [Centro]:

Digite 0,0,0 e pressione Enter

Duas dimensdes dindmicas sdo exibidas
que controlam o comprimento e a largura
da caixa (veja a imagem). A dimensdo
dindmica que é destacada em azul é a ativa.

Digite 5000 para o eixo x e pressione a
tecla Tab para alternar para a dimensdo
do eixoy.

Observe que a primeira dimensdo agora
estd realcada em rosa. Isso é para indicar
que um valor foi inserido aqui, e esse valor
agora estd bloqueado nessa dimensdo
dinamica.

Digite um valor de 1400 e pressione Enter.
Como alternativa, vocé pode pressionar
Tab novamente para voltar a primeira
dimensdo dinamica.

Finalmente, aparece uma dimensdo
dindmica que controla a altura da caixa.
Digite um valor de 2200 e pressione Enter.

BricsCAD’
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Manipulando a forma bésica de um objeto

1.

Queremos girar algumas faces da caixa para
criar uma forma mais interessante. Para
fazer isso, verifique se a Detec¢ao de Rosto

fl esta habilitada.

Passe o mouse sobre a face final da caixa
para que ela seja realcada em laranja e, no
Quad na guia Modelo, clique em GIRAR

Aparece um widget amarelo que indica a
direcdo e o eixo de rotagao. Mova o cursor
para perto da borda inferior do rosto, até
que o widget "gire" em torno dessa borda.

Mova o cursor para a direita para que o
rosto gire "para fora",

digite 10 e pressione Enter.
Faca o mesmo para o rosto superior:

gire-o 10 graus para baixo em torno de sua
borda esquerda (veja a imagem).

Faca o mesmo para a face oposta da caixa:
gire-a 15 graus para fora em torno de sua
borda inferior (veja a imagem).

No final, vocé deve acabar com uma forma
semelhante a mostrada na imagem final
(vista lateral).
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Deslocamento de bordas
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1. Noicone de controle de exibi¢ao ,/ \'\\ﬁ
| 1
(LookFrom), mantenha pressionada a tecla = m |
CTRL para selecionar Frente para baixo a
esquerda.
2. Alterar o modo de sele¢do para Sele¢do de
BAVWRNE| w90 @|E& & E = Modeling +  Modeling v @

borda ‘I

3. Selecione a borda inferior direita e, no
QUAD, na guia desenhar, clique em

DESLOCAMENTO e Digite o valor 1000.

4. OFFSET [ﬁ a nova linha, com uma
distancia de 2000.

5. Repita a etapa 4, com uma distancia de
1000.

Solid Edge
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2.6

Usando Push/Pull

Queremos usar um pouco de Push/Pull para
criar uma forma mais interessante.

1. Verifique se a Detecgao de Limite 1 esta
habilitada

2. Mova o cursor na face inferior do sélido
para que o limite seja real¢ado, conforme
mostrado na imagem a direita.

3. Depois de selecionar ou realgar esse limite,

use PUSH/PULL Cp e empurre essas
faces para dentro a uma distancia de 550.
Assim, vocé deve acabar com algo
semelhante, como mostrado na imagem
final.

4. Vamos criar limites na face frontal
desenhando uma LINHA do ponto de
extremidade ao ponto final para dividir a
parte superior da parte inferior. Consulte a
imagem para referéncia.

R

5. Selecione o limite e use: PUSH/PULL“Y e
empurre essas faces para dentro a uma
distancia de 120.

6. Repita o passo 4 na parte de tras do
edificio.

13. Repita a etapa 5 no limite traseiro.

Usando o Shell

Atualmente, nosso prédio ainda é apenas uma
caixa: se passarmos pelo nosso prédio, veremos
que ele ndo é oco, portanto, nenhum espaco
pode ser feito no interior.

1. Na GUIA Pagina Inicial -> Se¢des da Faixa

de Opc¢Bes, clique em SECTIONPLANE Cﬁi .
Vocé sera solicitado a algumas opcses,
selecione Frente de > Ortografica

2. Na guia Pagina Inicial -> Edi¢do Sélida da
Faixa de Opcdes, clique em SOLIDEDIT >

BODY > SHELLg
3. Selecione o sélido e pressione Enter.

4. Quando for solicitado a inserir a distancia de
deslocamento do shell, digite 30 e pressione
Enter.

s
@ | Push/pull
Pushes or pulls faces of a 3 solid

Db L
@ &% T
& @,

@ - ?‘f'; Auto Parar
:'_‘ i gt-| & o‘o ﬁj [
@ & @0l (A © B
Solid Editi Gti Separate

—_— [:31 Clean

©a Shell

@ Check
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14. Pressione Enter mais duas vezes para sair
do comando de edi¢do sélida.

Dividindo o modelo em partes separadas

NOTA: Para este exercicio, pratique a divisdo do
modelo seguindo as etapas abaixo. Se vocé ndo
conseguir concluir esta tarefa, abra o desenho:
EastBuilding_2. 8.dwg e continue trabalhando
no numero da li¢do: 2.8

(O desenho pode ser encontrado na pasta
"Arquivos intermediarios" no seu computador)

Arquivos intermediarios -> Exercicio 2

O solido agora é oco, mas ainda consiste em 1
Unico objeto. Em geral, queremos dividir o
modelo, de modo que cada objeto é uma
entidade separada.

1. Arquivo -> Abrir -> Arquivos
intermediarios -> Exercicio 2. Open o
desenho: EastBuilding_2.7.dwg

2. Verifique se a Sele¢ao de Rosto 9 esta
ativada

3. Selecione Face frontal e no QUAD

selecione  MULTISLICE % Vocé sera
solicitado a fornecer um valor de distancia,
digite 30 e pressione ENTER. Em seguida,
saia do comando.

4. Repat PASSO 2 para dividir a parede
traseira.

5.  Em seguida, divida a parede esquerda,
repetindo o PASSO 2.

6. Divida a parede direita, repetindo o PASSO
2.

7. Separe a laje do nivel do solo, repetindo o
PASSO 2.

8. Divida a laje do primeiro nivel, repetindo o
PASSO 2.
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10.

11.

Para separar a laje do primeiro nivel das
paredes do nivel do solo, esconda a parede
frontal, selecione a face superior da laje e

use o tipo MULTISLICE % 30 e pressione
ENTER.

Certifique-se de que as paredes do solo
também sejam divididas em paredes
individuais. Digite 30 para cada SLICE que
vocé fizer.

Para remover a abertura na laje, realce
qualquer uma das faces internas do orificio

(verifigue se a Deteccdo de Rosto ! esta
ativada) e, no Quad em Modelo, clique em

CONECTAR COM O MAIS PRéXIMO@

a9

\WAVAVAVAVAY

7
)
ALY
\VAVAVAY;
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Criando mais algumas paredes interiores e
lajes

Vamos mudar a conexao entre a laje do piso
superior e a parede destacada na imagem. Gire
o0 modelo para mostrar a parede curta oposta
da sala estreita.

1.

Selecione ambos os soélidos conforme
destacado na imagem e, na guia Quad em
Modelo, clique em CONEXAO DE SOLIDOS

DOTIPOL &I

Pressione a tecla Ctrl algumas vezes até que
a conexdo seja mostrada como na imagem,
ou seja, com a laje encostada na parede em
vez de descansar em cima dela. Pressione
Enter para aceitar.

Destaque a face superior da parede
(certifique-se de que a Detec¢do de Rosto
L esta ativada) e, no Quad em Modelo,
cligue em CONECTAR COM O MAIS

PROXIMO @ Isso conectara esta parede
com a laje do telhado, entdo agora temos
salas separadas dentro do nosso prédio.

Podemos criar mais algumas lajes de piso
interior. Podemos fazer isso simplesmente
copiando a laje do piso superior existente
na direcdo Z

Selecione todo o sélido da laje e use a
ferramenta COPY para adicionar mais 2
andares.

Mova o cursor para cima, digite 400 e
pressione Enter.

Observe que as duas lajes do piso superior
ndo estdo conectadas a parede final
inclinada. Podemos novamente usar

CONNECT WITH NEAREST @5 nas faces
finais para resolver este problema.
Realce a face final s das lajes (verifique se a

Deteccao de Rosto l:i esta ativada) e, no
Quad em Modelo, clique em CONECTAR

COM O MAIS PROXIMO @E Isso
conectara as lajes com a parede.
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Exercicio 3: Parametrizando Sélidos

BricsCAD’

As etapas a seguir dardo um exemplo de como transformar uma modelagem simples em um solido
parametrizado. Vocé aprendera algumas ferramentas basicas de parametriza¢do ao longo do caminho.

3.1

Parametrizando Sélidos

Primeiramente iremos fazer a modelagem de
um clindro. Para referencia vamos criar dois
circulos concéntricos um de raio 20 e outro de
raio 18.

Ative o comando extrude @ e selecione a
detec¢do de limetes entre os dois circulos é
crie a esrrusdo de 100.

Restricao de Raio

Abora com o cilindro modelado vamos dar inicio a
parametrizacao.

3.

Acesse o Ribbon Parametric e acione o

comando Radius € , selecione a aresta do
circulo externo e pressione Enter.

Agora repita o processo com a aresta do
circulo interno do cilindro.

. x
Acesso o painel Parametes Manager S e

confira as resticdes 3D criadas, no campo
Expession do Radius_2 (raio do circulo interno)
altere o valor para ‘Radius_1 - 2".

Nota: Quando utilizamos o nome de uma restri¢do
no valor de expressdo de outra, sera criado uma
dependéncia dessa restricdo em relacdo a que foi
usada em sua expressao.

Parameters Manager jo;
@ D> W& 4
Name Expression

v 3D Dimensional Constraints
(& Radius_1 20

A Radius_2 Radius_1-2
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Restricao de Distancia

6. Acione o comando Distance gﬂ, com o
comando acionado selecione a face inferior e a
face superior do cilindro, ap6és a selecdo
pressione Enter.

7. Confira a restricao dimensional 3D de distancia

criado no painel Parameters Manager S

8. Parafinalizar as restri¢des vamos utilizer o
comando Fix & na face inferior do cilindro.

Nota: Para conferir o comportamento das restri¢cdes
criadas acesse o painel Parameters Manager clique
com o botdo direito do mouse e acione a opcao
Animate.

~* Enabled

™ Create design table

Pbid Flip side

' Select geometry
[2] Animate

> Delete

Parameters Manager
@ D> W &

Name Expression

v 3D Dimensional Constraints

(& Radius_1 20
4 Radius_2 Radius_1-2
&4 Distance_3 100

3D Geometric Constraints
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